




U.S. CONTACT INFORMATION

9023 Columbine Road
Eden Prairie, MN 55347
Toll Free: 800-872-2599
Phone: 952-937-5161

Web: http://www.ontrackpowercontrols.com

Software Sales
Toll Free: (800) 645-3649
Email: software@ontrackpowercontrols.com

Technical Support
Phone: 952-937-2121
Email: support@ontrackpowercontrols.com
Web: http://www.ontrackpowercontrols.com/support
Hours: 8:00 a.m. - 5:00 p.m., M-F CST
Copyright © 2007 Kroll Ontrack Inc.



. .
 . 

. .
INTERNATIONAL CONTACT INFORMATION

Canada Australia
155 Gordon Baker Road Suite 210
Toronto, Ontario M2H 3N7
Canada

Web: http:www.ontrackpowercontrols.ca

28 Donkin Street, Suite #8
West End, QLD 4101
Australia

Web: http://www.ontrackpowercontrols.com.au

Software Sales
Toll Free: 800-645-3649
Email: software@ontrackpowercontrols.ca

Software Sales
Freephone: 1800 872 259
Email: software@ontrackpowercontrols.com.au

Technical Support
Phone: 952-937-2121
Email: support@ontrackpowercontrols.ca
Web: 
http://www.ontrackpowercontrols.ca/support

Technical Support
Phone: +61 7 3255 1199
Email: support@ontrackpowercontrols.com.au
Web: 
http://www.ontrackpowercontrols.com.au/support

United Kingdom France
The Pavilions, 1 Weston Road
Kiln Lane, Epsom
Surrey KT17 1JG
United Kingdom

Web: http://www.ontrackpowercontrols.co.uk

2, impasse de la Noisette
91371 Verrières-le-Buisson Cedex 413
France

Web: http://www.ontrackpowercontrols.fr

Software Sales
Tel: +44 (0)1372 741 999
Email: software@ontrackpowercontrols.co.uk

Support Commercial
Tél: +33 (0)1 69 53 66 92
Email: logiciel@ontrackpowercontrols.fr

Technical Support
Tel: +44 (0)1372 744 422
Email: support@ontrackpowercontrols.co.uk
Web: 
http://www.ontrackpowercontrols.co.uk/support

Support Technique
Tél: 0820 09 87 72
Email: support@ontrackpowercontrols.fr
Web: 
http://www.ontrackpowercontrols.fr/support

Germany Spain
Hanns-Klemm-Straße 5
71034 Böblingen
Deutschland

Web: http://www.ontrackpowercontrols.de

Primera Planta, Oficina B
C. Anabel Segura 7
28108 Alcobendas
Madrid
España

 Web: http://www.ontrackpowercontrols.es
Copyright © 2007 Kroll Ontrack Inc.



Software Sales
Tel: +49 (0)7031/644-0
Email: software@ontrackpowercontrols.de

Venta de Licencias
Tel: 900 112 012
Email: software@ontrackpowercontrols.es

Technical Support (available in German 
and English)
Tel: +49 (0)7031/644-244
Email: support@ontrackpowercontrols.de
Web: 
http://www.ontrackpowercontrols.de/support

Soporte técnico
Tel: 900 112 212
Email: soporte@ontrackpowercontrols.es
Web: 
http://www.ontrackpowercontrols.es/soporte

Norway* Italy

Postboks 1250
Arkoveien 14
2206 Kongsvinger
Norge

Web: http://www.ontrackpowercontrols.no

Via Lario, 1
I - 22070 Fenegró (CO)
Italia

Web: http:// www.ontrackpowercontrols.it

Software Sales

Software Sales
Toll-free: 810 10 100
Phone: +47 62 81 01 00
Fax: +47 62 81 01 10
Email: software@ontrackpowercontrols.no

Numero Verde: 800 44 00 33
Tel: +39 02 96943211
Fax: +39 02 96943221
Email: software@ontrackpowercontrols.it

Technical Support (available in English)

Technical Support
Phone: +47 62 81 01 00
Email: support@ontrackpowercontrols.no
Web: http://www.ontrackpowercontrols.no

Tel: +49 7031/644-244
Email: support@ontrackpowercontrols.it
Web: http://www.ontrackpowercontrols.it/support

Sweden* Denmark*
Drottninggatan 7
753 10 Uppsala
Sverige

Web: http://www.ontrackpowercontrols.se

H. P. Christensensvej 1
3000 Helsingør
Danmark

Web: http://www.ontrackpowercontrols.dk

Software Sales
Tel: +46 (0)18 10 44 40
Fax: +46 (0)18 10 99 20
Email: support@ontrackpowercontrols.se

Software Sales
Tel: +45 70 22 34 00
Fax: +45 70 22 34 01
Email: software@ontrackpowercontrols.dk
Copyright © 2007 Kroll Ontrack Inc.



. .
 . 

. .
* These locations are currently operating under the Ibas brand, which was acquired by Kroll Inc in 
2006.

Technical Support
Phone: +47 62 81 01 00
Email: support@ontrackpowercontrols.se
Web: http://www.ontrackpowercontrols.se

Technical Support
Phone: +47 62 81 01 00
Email: support@ontrackpowercontrols.dk
Web: http://www.ontrackpowercontrols.dk

Finland*
Norman Ibas Oy
Läkkisepäntie 11
00620 Helsinki
Finland

Web: http://www.ontrackpowercontrols.fi

Software Sales
Tel: +358 9 2727 210
Fax: +358 9 2727 2121
Email: software@ontrackpowercontrols.fi

Technical Sales
Tel: +358 9 2727 210
Email: support@ontrackpowercontrols.fi
Web: http://www.ontrackpowercontrols.fi
Copyright © 2007 Kroll Ontrack Inc.



Copyright © 2007 Kroll Ontrack Inc.



CONTENTS

TABLE OF CONTENTS

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Overview ...........................................................................................................................1

Five Major Reasons for Using Ontrack PowerControls....................................................1

Ontrack PowerControls 5.0 Enhancements .......................................................................2

System Requirements ........................................................................................................3
Ontrack PowerControls 5.0.........................................................................................3
Mailbox Creation Wizard............................................................................................4

Configuring Microsoft Outlook.........................................................................................5

Installing Ontrack PowerControls .....................................................................................5

Uninstalling Ontrack PowerControls.................................................................................5

Keyboard Shortcuts ...........................................................................................................6

Ontrack PowerControls Editions .......................................................................................7

Enabling the Licensed Agents ...........................................................................................9
The License File........................................................................................................11

About the Exchange Database.........................................................................................12
Organizing the Exchange Database Files for Ontrack PowerControls .....................13

Updating Ontrack PowerControls ...................................................................................13

Upgrading Ontrack PowerControls .................................................................................14

Getting Help ....................................................................................................................14
Online Help ...............................................................................................................14
Technical Support .....................................................................................................14

Conventions in this Manual.............................................................................................15
Menu Commands and Shortcuts ...............................................................................15
Shortcut Menu...........................................................................................................15
Notes and Tips ..........................................................................................................15

Chapter 1: Using the Ontrack PowerControls ExtractWizard . . . . . . . . 17
Overview .........................................................................................................................17

Prerequisites.....................................................................................................................17

Ontrack PowerControls ExtractWizard ...........................................................................18
Welcome Page...........................................................................................................18
Method of Extraction ................................................................................................19
Exchange Information Store Extraction Source........................................................21
Copyright © 2007 Kroll Ontrack Inc. i



TA B L E  O F  C O N T E N TS
Table of ContentsCONTENTS
Catalog Performance Options................................................................................... 22
Catalog Progress....................................................................................................... 24
Exchange Information Store Selection..................................................................... 25
Exchange Information Store Destination Folder...................................................... 32
Exchange Information Store Copy Progress ............................................................ 33
Completing the Wizard............................................................................................. 34

Organizing the Extracted Files for Ontrack PowerControls ........................................... 35

Chapter 2: Using the Ontrack PowerControls ExtractWizard 
Advanced Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Overview......................................................................................................................... 37

Using the API Method .................................................................................................... 39
Using the API Method for IBM Tivoli Storage Manager ........................................ 39
Using the API Method for EMC NetWorker ........................................................... 45

Using the Exchange Emulation Method ......................................................................... 52
Exchange Emulation for Microsoft NT Backup....................................................... 53
Exchange Emulation for HP OpenView Storage Data Protector ............................. 64
Exchange Emulation for Symantec Backup Exec 8.6 and 9.1/10.1/11d .................. 72
Exchange Emulation for CA ARCserve Backup...................................................... 88
Exchange Emulation for Veritas NetBackup ........................................................... 97
Exchange Emulation for CommVault Galaxy Backup & Recovery ...................... 115
Exchange Emulation for UltraBac.......................................................................... 124

Organizing the Extracted Files for Ontrack PowerControls ......................................... 131

Chapter 3: Looking at the Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
Overview....................................................................................................................... 133

Ontrack PowerControls Main Window......................................................................... 133
Source Pane ............................................................................................................ 134
Source Message List............................................................................................... 136
Target Pane............................................................................................................. 136
Target Message List (Restored Messages) ............................................................. 137
Menu Bar ................................................................................................................ 138
Toolbar ................................................................................................................... 139
Previewing and Opening Messages........................................................................ 140

Opening Attachments.................................................................................................... 141

Saving Attachments ...................................................................................................... 141

Changing the View........................................................................................................ 142
Viewing or Hiding the Toolbar and Status Bar ...................................................... 142
Resizing Panes Separated by a Split Bar................................................................ 142
ii Copyright © 2007 Kroll Ontrack Inc.



. .
 . 

. .TA B L E  O F  C O N T E N TS
Table of Contents
Sorting Messages in the Message Lists .................................................................. 143
Refreshing the Screen............................................................................................. 143

Viewing the Properties of an EDB File, PST File, CAS File, CAS Profile 
Folder, Folder, or Mailbox ..................................................................................... 144

Performing an Integrity Check...................................................................................... 147

Viewing Deleted Messages........................................................................................... 147

Setting Preferences........................................................................................................ 148
Options Tab ............................................................................................................ 148
Security Tab............................................................................................................ 150
Warnings Tab ......................................................................................................... 151

Chapter 4: Using Ontrack PowerControls  . . . . . . . . . . . . . . . . . . . . . . 153
Overview....................................................................................................................... 153

Running the Data Wizard.............................................................................................. 153
Configuring Ontrack PowerControls...................................................................... 153
Before You Use the Data Wizard........................................................................... 155
Data Wizard: Welcome Page.................................................................................. 155
Data Wizard: Source Path Selection....................................................................... 155
Guidelines for Selecting an Exchange Database .................................................... 156
Data Wizard: Target Type and Path Selection ....................................................... 157
Data Wizard: Now Processing Data File................................................................ 161
Data Wizard: Completing the Data Wizard............................................................ 162
Looking at the Ontrack PowerControls Main Window after 

Using the Data Wizard..................................................................................... 163
Returning to the Data Wizard................................................................................. 163

Opening the Source Database and Target Mailboxes from the 
Main Window......................................................................................................... 164
Before You Proceed ............................................................................................... 164
Opening Source and Target Files ........................................................................... 166
Opening a Live Microsoft Exchange Server as a Target........................................ 169
Opening Multiple Sources and Targets .................................................................. 175
Closing Sources and Targets .................................................................................. 175
Deleting Items in the Target Pane .......................................................................... 176

Using the Mailbox Creation Wizard ............................................................................. 176
User Permission...................................................................................................... 176
Creating Mailboxes ................................................................................................ 176
Preference Settings ................................................................................................. 183

Auditing Failure ............................................................................................................ 183
Copyright © 2007 Kroll Ontrack Inc. iii



TA B L E  O F  C O N T E N TS
Table of ContentsCONTENTS
Chapter 5: Finding Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Overview....................................................................................................................... 185

Guidelines for Using the Find window......................................................................... 185

Searching Sources ......................................................................................................... 186
Searching Embedded Message Items ..................................................................... 189
Searching Within Results ....................................................................................... 189

Searching Microsoft Exchange Server Target .............................................................. 191
Managing Message Items ....................................................................................... 191

Saving and Using Search Profiles................................................................................. 194

Using Multiple Search Windows .................................................................................. 195

Searching Within Attachments ..................................................................................... 196
Exceptions When Searching Within Attachments ................................................. 196

Other Ontrack PowerControls Features Available Through the 
Find Window.......................................................................................................... 197
Opening and Saving Attachments in the Find Window ......................................... 197
Exporting Message Items from the Find Window ................................................. 197
Restoring Message Items from the Find Window.................................................. 197
Performing an Integrity Check on Message Items in the Find in 

Source Window................................................................................................ 197
Search Results Report ................................................................................................... 198

Save Report ............................................................................................................ 198

Chapter 6: Exporting Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Overview....................................................................................................................... 201

General Information about Exporting Messages .......................................................... 201

About Message (.msg), Text (.txt), and PST Export..................................................... 201

Exporting Messages ...................................................................................................... 202

Exporting to PST........................................................................................................... 205
Output ..................................................................................................................... 206

About the Export Progress Window ............................................................................. 207

Saving and Printing the Report ..................................................................................... 208

Chapter 7: Restoring Exchange Data . . . . . . . . . . . . . . . . . . . . . . . . . . 209
Overview....................................................................................................................... 209

Quick Look at Restoring Your Exchange Data ............................................................ 209
Restoring Your Exchange Data in Three Easy Steps ............................................. 209
Limits for PST and Folder Targets......................................................................... 210
iv Copyright © 2007 Kroll Ontrack Inc.



. .
 . 

. .TA B L E  O F  C O N T E N TS
Table of Contents
About Restoring Messages to an Exchange Server................................................ 211
About the Copy Progress Window......................................................................... 211
Creating, Renaming, and Deleting Folders in the Target Pane .............................. 212
Copying and Pasting or Dragging and Dropping ................................................... 213

Examples of Restoring Your Exchange Data ............................................................... 214
Restoring Messages with Copy-Paste .................................................................... 214
Restoring Messages with Paste Special.................................................................. 215
Restoring a Folder .................................................................................................. 220
Restoring a Mailbox ............................................................................................... 222
Restoring an EDB File............................................................................................ 223
Restoring to Public Folders .................................................................................... 224

Chapter 8: Using the Command Line  . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Overview....................................................................................................................... 227

Command Line Syntax.................................................................................................. 227

Examples of Using the Command Line ........................................................................ 229

Chapter 9: Reporting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
Overview....................................................................................................................... 235

Creating Reports ........................................................................................................... 235

Viewing Reports ........................................................................................................... 238
Single Instance Storage (SIS) vs. Cumulative Counts ........................................... 238
Attachment Statistics Report .................................................................................. 239
Domain Statistics Report........................................................................................ 239
Messages by Database Report ................................................................................ 240
Messages by Mailbox Report ................................................................................. 241
Messages by Date Report ....................................................................................... 242
Messages by Profile Folder .................................................................................... 243

Sorting Reports ............................................................................................................. 243

Saving Reports .............................................................................................................. 244

Chapter 10: Content Analysis Store . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
Overview....................................................................................................................... 245

Creating a Content Analysis Store ................................................................................ 246
Creating and Processing Content Analysis Store Profile Folders .......................... 248
Suspending and Resuming Content Analysis Store Profile Folders ...................... 253
Adding Sources to Content Analysis Stores........................................................... 255
Editing and Deleting Profiles ................................................................................. 256
Closing a Content Analysis Store........................................................................... 256
Copyright © 2007 Kroll Ontrack Inc. v



TA B L E  O F  C O N T E N TS
Table of ContentsCONTENTS
Opening a Content Analysis Store as Source ......................................................... 257
Viewing Properties of a Content Analysis Store.................................................... 258
Creating Reports in Content Analysis Store........................................................... 259
Viewing Profiles in Content Analysis Store........................................................... 259
Missing Database Files........................................................................................... 260
Wrong Database Files............................................................................................. 261

Chapter 11: Message Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
Overview....................................................................................................................... 263

Message Views Menus and Toolbars............................................................................ 264
Message Views Menus ........................................................................................... 264
Message Views Toolbar Icons................................................................................ 264
Message View Shortcut Menu................................................................................ 264

Message View Pane ...................................................................................................... 266
Other Options Available in the Message View ...................................................... 266

Message View Options ................................................................................................. 267
Message Table View .............................................................................................. 267
Attachment Table View.......................................................................................... 268
Conversation View ................................................................................................. 269
Opening a View for the First Time......................................................................... 270

Find in Source Window in Message Views .................................................................. 272

Glossary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 277
vi Copyright © 2007 Kroll Ontrack Inc.



INTRODUCTION

INTRODUCTION

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Welcome to Ontrack® PowerControls™ 5.0, the mailbox recovery software that saves time, 
money, and resources when recovering Microsoft Exchange data.

Ontrack PowerControls works with your existing Microsoft Exchange Server backup architecture 
and procedures, and allows you to recover individual mailboxes, folders, messages, attachments, 
calendar items, notes, and tasks directly to your production Exchange Server or any PST file. This 
eliminates time-consuming and expensive single mailbox (brick-level) backups. This powerful 
software also lets you search and create a copy of all archived email that matches a given keyword 
or criteria. 

The Ontrack® PowerControls™ ExtractWizard lets you restore Exchange Information Store data 
from tape and disk backups to any alternate location (e.g., machine, volume, folder), thereby 
eliminating the need for a recovery server. In contrast, most backup programs let you restore 
Exchange data only to the same or duplicate server from which it was backed up.

This user guide provides step-by-step instructions for completing specific tasks on the Windows 
platform. See the table of contents or the Index to locate the pages on which particular topics are 
discussed.

Use Adobe Acrobat to open the PDF version of this user guide. After you open the PDF file, click 
the Hand tool to view the Table of Contents hyperlinks in layout view. Then click a hyperlink to 
jump to a specific topic in the manual.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Five Major Reasons for Using Ontrack PowerControls

There are five primary ways you can benefit from using Ontrack PowerControls:

Minimize the time to restore an individual mailbox. Ontrack PowerControls can slash restore 
time, making it possible to restore mail items from a previous full backup directly into your 
production Exchange Server, or directly into a new or existing PST file. This eliminates the need 
for a recovery server and the extra steps required to separately import mail back into Exchange or 
Outlook.

Eliminate backups of an individual mailbox. Ontrack PowerControls eliminates the need to back 
up individual mailboxes because they can be restored directly from an EDB file.

Minimize the time to locate all email matching specific criteria. Ontrack PowerControls 
includes an Advanced Find feature that can search across all mailboxes in an archive EDB file, 
rather than searching one mailbox at a time or bringing an old backup back online for analysis. And 
you can search by a variety of criteria, including keywords, subject, date and specific users.

Minimize storage space and the cost required to store and archive your backups. Because you 
don’t need to back up mailboxes individually doing a brick-level backup, you eliminate the backup 
space, cost, and time associated with performing brick-level backups.
Copyright © 2007 Kroll Ontrack Inc. 1



I N T R O D U C T I O N
Ontrack PowerControls 5.0 EnhancementsINTRODUCTION
Minimize the time to back up all mailboxes. Ontrack PowerControls eliminates the need to back 
up mailboxes individually. Normally, companies do a full Exchange backup, and then run a second 
process to back up “Very Important Mailboxes” (VIMs) individually as well. Ontrack 
PowerControls eliminates this second process.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls 5.0 Enhancements

Ontrack PowerControls 5.0 contains all the features and benefits of Ontrack PowerControls 4.2 
plus these exciting new and improved features: 

• Live Microsoft Exchange Server as a Target: You can open live Exchange Servers as a 
Target within Ontrack PowerControls. 

• Searching Microsoft Exchange Server Target: You can search a Exchange Server Target 
and perform actions on the search results. 

• Mailbox Creation Wizard: You can create mailboxes on a Target Exchange Server 
manually or as part of copy and paste process. This gives you the ability to create a new 
mailbox-enabled user, or to create a new mailbox for an existing user. 

• Search Results Report: You can save a text-based report of the search results without 
having to copy or export any of the actual search results. The search results report includes 
search criteria, date/time the search was started, and a report of messages that matched the 
criteria.

• Export to PST: The Export to PST feature provides you a method for selecting a single 
mailbox from an off-line EDB or an entire off-line EDB and exporting to PST files—one 
for each mailbox.

• Journaling Support: Ontrack PowerControls has added the capability to search multiple 
levels of embedded messages. 

• Exchange Server 2007 support in ExtractWizard: ExtractWizard functionality has been 
expanded to support current product releases of Agent-supported backup software products 
offered by Ontrack PowerControls ExtractWizard Agents. Also, ExtractWizard 
functionality has been expanded to support current product releases of Agent-supported 
backup software products offering Exchange Server 2007 support. 
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. .I N T R O D U C T I O N
System Requirements
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
System Requirements

This section covers System Requirements for Ontrack PowerControls 5.0 and the minimum 
software requirements for Mailbox Creation Wizard.

Ontrack PowerControls 5.0

To use Ontrack PowerControls on your computer, you need the following hardware and software: 

• One of the following operating systems:
• Windows 2000 Server
• Windows 2000 Professional
• Windows XP Professional
• Windows 2003 Server
• Windows Vista Business
• Windows Vista Ultimate (32-bit and 64-bit versions)
• Windows Vista Enterprise

Note:  Ontrack PowerControls in Vista can only be run by users with administrative 
privileges and in administrative mode.

• Microsoft Outlook 2000 or later. Machine must have Outlook 2000 or greater installed and 
Outlook must have been run at least once to configure Outlook’s settings. Additionally, 
those versions of Outlook that make a distinction between “Internet Email” and “Corporate 
Email” need to be configured for the latter.

• For Exchange Server 5.5: Microsoft Outlook 2000 or Outlook 2003 is required.

Note:  Microsoft Outlook 2007 cannot connect to an Exchange Server 5.5. However, 
Microsoft Outlook 2007 can be used with Ontrack PowerControls to access an .edb file 
originating from an Exchange 5.5 environment.

• For Exchange Server 2000 and Exchange Server 2003: Microsoft Outlook 2000 or 
later is required.

• For Exchange Server 2007: Microsoft Outlook 2003 or Outlook 2007 is required. 

Note:  The Operating Systems listed above and Microsoft Outlook are required to have the latest 
service packs installed.

• Microsoft .NET 2.0 framework
• Intel ® Pentium® compatible processor 
• 1024 MB RAM minimum
• 200 MB of free hard disk space for the installation. More disk space will be needed for 

processing log files when opening an EDB file.
• Monitor with 800 x 600 or higher screen resolution 
• USB port (for Ontrack PowerControls product licenses requiring HASP key dongle to run 

application)
Copyright © 2007 Kroll Ontrack Inc. 3



I N T R O D U C T I O N
System RequirementsINTRODUCTION
Note:  Ontrack PowerControls 5.0 supports Microsoft Exchange 5.5, Exchange Server 2000, 
Exchange Server 2003, or Exchange Server 2007. If running Ontrack PowerControls with 
Exchange Server 2007, Outlook 2003 or Outlook 2007 must be installed and configured.

Ontrack PowerControls is designed to run from a Microsoft Windows workstation and uses native 
Microsoft Messaging APIs (MAPI) to communicate to the Exchange Server, ensuring reliable and 
consistent operation of your server. For MAPI to initialize properly, Microsoft Outlook must be 
installed and configured on the workstation to connect to an Exchange Server. When connecting to 
an Exchange Server 2007, Microsoft Outlook 2003 or Outlook 2007 must be installed and 
configured.

While Ontrack PowerControls is designed to run from a Microsoft Windows workstation, Exchange 
Server 2007 installation configuration is supported. If running Ontrack PowerControls on 
Exchange Server 2007, Microsoft Outlook 2003 or Outlook 2007 must be installed and configured 
on the Exchange Server. Ontrack PowerControls does not support other Exchange Server 
installation configurations.

Mailbox Creation Wizard

To use Mailbox Creation Wizard on your computer, you need these minimum software 
requirements.

The Exchange Management Tools can be installed on Windows XP Professional, Windows 2000 
Professional, Windows 2000 Server; Windows 2000 SP3, or Windows Server 2003. To see 
additional supported operating system  and prerequisite requirements, please refer to the Exchange 
Management Tools documentation for your specific version. 

*The Exchange 2000 Management Tools can only be used on Exchange Server 2000 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server, 
Windows 2000 SP3, or Windows Server 2003.

**The Exchange 2003 Management Tools can be used on Exchange 2000 or 2003 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server SP3, or 
Windows Server 2003.

Exchange Server Software Required Prerequisites

Exchange 2000 Exchange 2000 
Management Tools* 

Windows 2000 Administrative Tools

Exchange 2003 Exchange 2003 
Management Tools** 

Internet Information Server (IIS) 

Windows Server 2003 SP1 Administrative 
Tools Pack

Exchange 2007 Exchange 2007 
Management Tools*** 
(64-bit: CD; 32-bit: 
download)

IIS

.NET Framework 2.0

MMC 3.0

PowerShell 1.0
4 Copyright © 2007 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Configuring Microsoft Outlook
***The Exchange 2007 Management Tools can only be used on Exchange Server 2007 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server SP3, or 
Windows Server 2003.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring Microsoft Outlook 

Ontrack PowerControls requires that Microsoft Messaging API (MAPI) be installed on your 
computer. To get full MAPI functionality, do the following before installing Ontrack 
PowerControls:

1. Make sure that Microsoft Outlook is installed and has been run once.
2. Set up an email account on a Microsoft Exchange Server.
3. For those versions of Microsoft Outlook that distinguish between “Internet Email” and 

“Corporate Email,” use “Corporate Email” when configuring Microsoft Outlook.
4. Run Microsoft Outlook again, and connect to the Exchange Server.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Installing Ontrack PowerControls

Follow these steps to install Ontrack PowerControls:

1. Install and configure Microsoft Outlook as described in “Configuring Microsoft Outlook.”
2. Turn off any disk utility or antivirus program running in the background.
3. Insert the Ontrack PowerControls CD-ROM into your CD-ROM drive.
4. The installation program automatically starts. If it does not, click Run on the Start menu, 

and type D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your CD-ROM 
drive. Click OK.

5. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Uninstalling Ontrack PowerControls

You can uninstall Ontrack PowerControls by running the uninstall program.

1. Click Start and then click Control Panel. (In Windows 2000 and earlier, you point to 
Settings before you click Control Panel.)

2. In Control Panel, click the Add or Remove Programs icon.
3. Click Ontrack PowerControls 5.0, and then click Change/Remove.
4. Click Yes when the confirmation dialog box appears.
5. Follow the on-screen instructions.
Copyright © 2007 Kroll Ontrack Inc. 5
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Keyboard ShortcutsINTRODUCTION
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Keyboard Shortcuts

Menu Bar Keyboard Shortcut

File Menu

Open Source Ctrl+S

Open Target PST Ctrl+T

Open Target Exchange Server Ctrl+E

Close Store Ctrl+L

User Data Wizard Ctrl+W

Exit Alt+F4

Edit Menu

Copy Selection to Clipboard Ctrl+C

Paste Copied Item(s) Ctrl+V

Paste Special Ctrl+Y

Delete DEL

Rename Ctrl+R

New Folder Ctrl+N

New Mailbox Ctrl+M

Move To Folder (Microsoft Exchange 
Server as a Target - Find window)

Ctrl+Shift+V

Cut (Microsoft Exchange Server as a 
Target - Find window)

Ctrl+X

View Menu

Refresh Screen F5

Tools Menu

Integrity Check Ctrl+I

Export Ctrl+P
6 Copyright © 2007 Kroll Ontrack Inc.



. .
 . 

. .I N T R O D U C T I O N
Ontrack PowerControls Editions
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls Editions

Ontrack PowerControls software editions are licensed based on the number of servers and 
mailboxes in your environment. The Standard Edition is licensed for use on a single server with up 
to 100 mailboxes and the Business Edition is licensed for use on a single server with up to 250 
mailboxes. The Enterprise Edition is licensed for a customized number of servers and mailboxes. 
The Commercial Edition is licensed based on an unlimited number of servers and mailboxes for a 
specified period of time. 

Create Reports Ctrl+O

Find F3

Online Help

View Help F1

Menu Bar Keyboard Shortcut
Copyright © 2007 Kroll Ontrack Inc. 7



I N T R O D U C T I O N
Ontrack PowerControls EditionsINTRODUCTION
Ontrack PowerControls also offers a free edition. With this edition, you can open an Exchange 
database (EDB) file, search mailboxes one at a time, and view messages. 

Ontrack 
PowerControls 

Edition

Ontrack 
PowerControls 

Feature

Agents Feature
EW = Ontrack PowerControls 

ExtractWizard
PC = Ontrack PowerControls

Ontrack 
PowerControls 5.0 
Standard Edition

100 mailbox and 
server name 
enforcement

EW Agent for Microsoft® NT Backup 
(included)

EW Agent for Symantec Backup Exec™ 
(priced separately)

EW Agent for EMC® NetWorker® (priced 
separately)

EW Agent for CA ARCserve® Backup (priced 
separately)

EW Agent for VERITAS NetBackup™ (priced 
separately)

EW Agent for IBM® Tivoli® Storage 
Manager (priced separately)

EW Agent for HP OpenView® Storage Data 
Protector (priced separately)

EW Agent for CommVault® Galaxy™ 
Backup & Recovery (priced separately)

EW Agent for UltraBac (priced separately)

PC Agent for PST Source (price separately)

PC Agent for Advanced Searching (priced 
separately)

PC Agent for Content Analysis Store (priced 
separately)

PC Agent for Administrative Services (priced 
separately)

Ontrack 
PowerControls 5.0 
Business Edition

250 mailbox and 
server name 
enforcement

Ontrack 
PowerControls 5.0 
Enterprise Edition

Server name 
enforcement

Ontrack 
PowerControls 5.0 
Commercial Edition

Subscription 
enforcement

All agents included and fully enabled

Ontrack 
PowerControls 5.0 
Free

All features included 
and partially enabled 
(open any .edb file, 
view all mailboxes, 
search one, copy 
none)

For Direct Method: All Agents included and 
partially enabled (each Agent allows you to 
read and view from any source but cannot 
extract or copy any data out).

For Advanced Method: No agents are enabled.

EW Agents allow you to save the catalog file.
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. .I N T R O D U C T I O N
Enabling the Licensed Agents
Technical Note: Ontrack PowerControls can process both Private Information Stores (priv.edb, 
containing mailboxes) and Public Information Stores (pub.edb, containing public folders). In 
Ontrack PowerControls, a private store mailbox = public store root folder. Ontrack PowerControls 
does not open either type of .edb file with more mailboxes than originally licensed for. For example, 
if you purchased the Standard Edition (for 100 mailboxes per server), and try to open an .edb file 
with 101 mailboxes, the product refuses to open the file because it exceeds 100 mailboxes.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Enabling the Licensed Agents

Each edition of Ontrack PowerControls is distributed with nine Ontrack PowerControls 
ExtractWizard Agents and three Ontrack PowerControls Agents. The Ontrack PowerControls 
ExtractWizard Agent for Microsoft NT Backup is included with the program at no extra cost, and is 
enabled by default. All other Agents are shipped with all Ontrack PowerControls editions in 
disabled conditions and require a new license file to enable them. 

Ontrack 
PowerControls 
ExtractWizard 

Agent
Versions 

Supported Disk Backup Tape Backup

Agent for Microsoft® 
NT Backup

All Versions .BKF Files Microsoft Tape 
Format (MTF)

Agent for Symantec 
Backup Exec™

8.x, 9.x, and 10.1 and 
11.d

.BKF Files Microsoft Tape 
Format (MTF)

Agent for EMC® 
NetWorker®

6.x and 7.0 through 
7.43

.0 Files NetWorker Tape 
Format

Agent for CA 
ARCserve® Backup

9.x, 11.52, and 11.5 
SP32,5

.CTF (ARCserve) 
Files

ARCserve Tape 
Format

Agent for VERITAS 
NetBackup™

4.5, 5.x, 6.0, and 6.51 _C1_F 
(NetBackup) Files

VERITAS 
NetBackup Tape 
Format

Agent for IBM® 
Tivoli® Storage 
Manager

5.1, 5.2, 5.34, and 5.44 .BFS and .OST 
Files

Tivoli Tape Format

Agent for Hewlett-
Packard OpenView® 
Storage Data 
Protector

4.2 and 5.x User-Defined File 
Extension

Hewlett-Packard 
OpenView Storage 
Data Protector Tape 
Format

Agent for 
CommVault® Galaxy 
™ Backup & 
Recovery

5.0 and 5.9 Backup Path CommVault Galaxy 
Tape Format
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I N T R O D U C T I O N
Enabling the Licensed AgentsINTRODUCTION
1) For NetBackup 6.x backups created using Bare Metal Restore or Off-Host Backup, Ontrack 
recommends the Advanced Method for extraction.

2) For CA ARCserve 11.5 multiplexed backup tapes, Ontrack recommends the Advanced Method 
for extraction.

3) For EMC NetWorker 7.2, 7.3, and 7.4 backups created using Advanced File Backups, Ontrack 
recommends the Advanced Method for extraction.

4) For IBM Tivoli Storage Manager 5.3 and 5.4 backups created using Export mini format, Ontrack 
recommends the Advanced Method for extraction.

5) For CA ARCserve 11.5 SP3 backups of Microsoft Exchange Server 2007 created using 
Advanced Mode, Ontrack recommends the Direct method for extraction.

In addition to Ontrack PowerControls ExtractWizard Agents, Ontrack PowerControls users also 
have the option to purchase other unique add-on features for enhanced search and analysis 
capabilities.

To view the currently enabled Agents 

• On the Help menu, click About and then click License Info.

To enable an Agent 

1. Contact a sales representative and specify which agent you wish to purchase. A license file 
containing the newly enabled agent will be sent to you. 

Note:  To contact a sales representative, see the contact information at the beginning of this 
user guide.

2. Replace the existing .ini file with the new .ini file. The default location for this file is in the 
Ontrack PowerControls directory. 

Agent for UltraBac 7.1 and 8.0 Magnetic Library UltraBac Software 
Tape Format

Ontrack PowerControls Agent Version Supported

Agent for PST as Source Microsoft Outlook 97 or later

Agent for Advanced Searching Not applicable

Agent for Content Analysis Store Not applicable

Agent for Administrative Services Not applicable

Ontrack 
PowerControls 
ExtractWizard 

Agent
Versions 

Supported Disk Backup Tape Backup
10 Copyright © 2007 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Enabling the Licensed Agents
The License File

All Ontrack PowerControls editions require a license file. The purpose of this file is to let you buy 
only those features you need. Before Ontrack PowerControls is enabled, it checks the .ini file for 
five things:

• The license file must be valid for Ontrack PowerControls 5.0. 
• Mailbox limit if applicable.
• Server name enforcement if applicable. Allows users to open EDB files only from the 

licensed server names.
• Subscription length if applicable.
• Enabled Agents (Ontrack PowerControls ExtractWizard Agents, Ontrack PowerControls 

Agents)

Tip:  If you have the Ontrack PowerControls Standard Edition (100 mailboxes), and you attempt to 
open an EDB file with 101 mailboxes, Ontrack PowerControls will not open the file.

Note:  To view and/or change the location of the license file, see “Setting Preferences” on 
page 148. In the Ontrack PowerControls Preferences window, click the Options tab and read the 
instructions for the “License file name” preference.

Example of a license file: Ontrack PowerControls license file - Standard Edition with 6 
Agents enabled

;==================================================================

;Kroll Ontrack Inc. License File

;Any modification will invalidate this file

;Copyright© 2007 Kroll Ontrack Inc.

;==================================================================

[Product]

Product=Ontrack PowerControls 5.0

[Edition]

Standard 0x5203=Mb0tLhF7bt0qqycXmnoiuxsyyMvnCbDYE49gHoBZ5hE=

[SLN]

SLN=Ontrack PowerControls 5.0 Standard Edition

[Licensed Mailboxes]

100=U71pLkB7AN0=

[Licensed Agents]
Copyright © 2007 Kroll Ontrack Inc. 11



I N T R O D U C T I O N
About the Exchange DatabaseINTRODUCTION
PCA50D2-FCB8KM=Mr0aLjF7Nd1+qwIX2npru30yu8vdCb3Yao8dHrNZ

PCA50E2-BEC69X=Mr0aLjF7Nd1+qwMX2npru3kyvcvcCbPYGI8IHrNZ

PCA5092-CEB7ZE=Mr0aLjF7Nd1+q38X2npru3gyvcvdCbLYe48VHrNZ

PCA50F2-58DEZY=Mr0aLjF7Nd1+qwAX2npruw4ywMvbCcDYe48JHrNZ

PCA5032-EFXAPH=Mr0aLjF7Nd1+q3UX2npru34yvsvHCcTYcY8YHrNZ

PCA5072-A33FDL=Mr0aLjF7Nd1+q3EX2npru3oyy8usCcPYZY8cHrNZ

;PCA50D2-FCB8KM = Agent for Advanced Searching

;PCA50F2-58DEZY = Agent for Administrative Services

;PCA50E2-BEC69X = Agent for Content Analysis

;PCA5092-CEB7ZE = Agent for PST as Source

;PCA5032-EFXAPH = Agent for NT Backup

;PCA5072-A33FDL = Agent for Veritas NetBackup

;

[Licensed Servers]

1. ExchangeServer1=U713LlB7Rd02qyUXgHonu1Uyn8v6CdbYRI8iHsVZgxGcg7HCVyk=

;

[AUTHENTICATION]

Checksum=b422

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
About the Exchange Database1 

The Exchange database consists of the following files:

• .edb file (rich text database file) contains data placed in the store through Messaging 
Application Programming Interface (MAPI), as well as all the database tables that define 
mailboxes, messages, folders, and attachments. 

• .stm file (streaming database file) contains common Internet formatted content, such as 
Multipurpose Internet Mail Extensions (MIME) content, that protocols other than the MAPI 
protocol place in the store.  

Note:  The .stm file is new to Exchange 2000. Exchange 5.5 does not contain .stm files. 

• .log files (transaction logs) are history files recording server activity. These files are useful 
in restoring and backing up Exchange data. Transaction logs for Exchange Server 5.5, 2000, 
and 2003 are 5 MB in size. Transaction logs for Exchange Server 2007 are 1 MB in size.

Each storage group uses its own set of transaction log files. For example, if a storage group 
contains five stores, all transactions for all five stores are recorded in a single series of 

1. The information in this section is taken from Microsoft Training and Certification: Implementing and 
Managing Microsoft Exchange 2000. Workbook. Redmond, WA: Microsoft Press, 2001.
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. .I N T R O D U C T I O N
Updating Ontrack PowerControls
transaction log files. You can determine where to locate the transaction log files for each 
storage group.

• .chk (check) files are checkpoint files used for recovering (playing) data from transaction 
logs into EDB files. The checkpoint is the place marker in the EDB.CHK file that indicates 
which transactions have been committed. Whenever data is written to an EDB file from the 
transaction log, the EDB.CHK file is updated with information specifying that the 
transaction was successfully committed to the respective EDB file. Separate Exx.chk files 
are maintained for each storage group using ESE (Extensible Storage Engine). 

• .pat (patch) files are used to record information on page splits in Exchange 5.5 through 
Exchange 2000 (SP1). In Exchange 2000 (SP2) and later, the functionality provided by .pat 
files is incorporated into Exchange log files.

Organizing the Exchange Database Files for Ontrack PowerControls

For best results when using an online incremental or differential backup

• Put the .edb, .stm, and .pat files in one directory. 
• Put the associated log files (e.g., .log, .chk) in one directory. 

Note:  The two directories can be different.

Ontrack PowerControls does not require .stm or .log files, but you should include them to ensure 
that all email data is recovered. You may get corruption errors if these files are not present. 

If you are using an offline backup

You need to use the .edb and .stm files for offline backups. To ensure that all email data is 
recovered, you should also include all .log files, as well as .pat and .chk files if they exist. Ontrack 
PowerControls performs its own verification process and includes the .log and .pat files to 
determine if it needs them to recover the data.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Updating Ontrack PowerControls

Kroll Ontrack periodically improves Ontrack PowerControls—adding features, making changes 
based on customer requests, and fixing problems. When these updates (also known as patches) are 
available to you, EasyUpdate™ can download and install them in minutes.

If there are multiple components for updating, EasyUpdate provides you with a list of options—you 
can update everything, or select a subset of options.

We recommend running EasyUpdate as soon as you purchase and install Ontrack PowerControls, 
just in case there is a program patch that was not included with your version.

To run EasyUpdate

1. Do one of the following:
• In Ontrack PowerControls: On the Help menu, click EasyUpdate. 
• In Windows: Click Start, and then point to Programs. Point to Ontrack, point to 

Ontrack PowerControls, and then click EasyUpdate.
2. Follow the on-screen instructions.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Upgrading Ontrack PowerControls

If Ontrack PowerControls 4.2 has been previously installed, is active, and you are upgrading to 
Ontrack PowerControls 5.0, you will not be able to reuse the existing Ontrack PowerControls 4.2 
license file with Ontrack PowerControls 5.0. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Getting Help

Kroll Ontrack provides you with the following ways to get help with Ontrack PowerControls: 
“Online Help” and “Technical Support”.

Online Help

Online Help includes all of the information in the user guide and more, and it lets you quickly 
access this information by using one of three tabs. The Contents tab offers a hierarchical view of 
the contents of the user guide. The Search tab offers a full-text search of the user guide. The Index 
tab offers a keyword-based way to get to specific topics.

To start online Help

Do one of the following:

• On the Help menu, click Contents.
• Click  on the toolbar.
• Press the F1 key.

To identify a tool or control

• Position the pointer over a tool or control, and then pause. A tool tip shows the name of the 
item.

Technical Support

If you have questions or problems not answered in the user guide or the online Help (F1), call our 
Technical Support group. When reporting an issue, please include any information that might help 
us diagnose the problem. The following details are often the most helpful:

• The version of Ontrack PowerControls you are using (on the Help menu, click About).
• The versions of Windows and Outlook that you are running.
• The version of Exchange that contained the Source EDB file.
• The circumstances and sequence of steps that led to the problem.
• The text of the error messages (if any appeared), and the contents of the Details window.
• A list of other Windows programs that you were running when the error occurred.

See “U.S. Contact Information” and “International Contact Information” at the beginning of this 
user guide.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Conventions in this Manual

This manual uses guidelines for documenting menu commands and shortcuts; commands available 
on shortcut menu; and notes and tips. 

Menu Commands and Shortcuts

This manual uses the following conventions for documenting menu commands and shortcuts:

Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to display a shortcut menu. The contents of the shortcut menu depend on 
whether you right-click in the Source or Target pane. This manual seeks to teach you how to use 
commands on the menu bar and toolbar, and doesn’t always specify when you can use the shortcut 
menu. Once you become familiar with Ontrack PowerControls, the commands available to you on 
the shortcut menu should become apparent.

Notes and Tips1

Notes (including cautions, important notes, tips, and warnings, as well as general notes) call the 
user’s attention to information of special importance or information that can’t otherwise be suitably 
presented in the main text.

Note indicates neutral or positive information that emphasizes or supplements important points of 
the main text. A note supplies information that may apply only in special cases-for example, 
memory limitations, equipment configurations, or details that apply to specific versions of a 
program.

Tip helps users apply the techniques and procedures described in the text to their specific needs. A 
tip suggests alternative methods that may not be obvious and helps users understand the benefits 
and capabilities of the product. A tip is not essential to the basic understanding of the text.

Important provides information essential to the completion of a task. Users can disregard 
information in a note and still complete a task, but they should not disregard an important note.

Caution advises users that failure to take or avoid a specified action could result in loss of data.

Example Describes

On the File menu, point to Target PST, 
and then click Create New.

Choosing the Create New command on the 
Target PST submenu on the File menu.

On the Edit menu, click Paste Special. Choosing the Paste Special command on the 
Edit menu.

Press Ctrl+S (Open Source EDB) Holding down the Ctrl key and the S key at 
the same time and then releasing them.

Right-click Clicking the right mouse button.

1. The information in this section is taken from the Microsoft Manual of Style for Technical 
Publications, 3rd Edition. Redmond, WA: Microsoft Press, 2002.
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CHAPTER 1

USING THE ONTRACK POWERCONTROLS 

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
EXTRACTWIZARD CHAPTER 1 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

If you have not yet extracted backed-up Exchange Information Store data, try using Ontrack® 
PowerControls™ ExtractWizard. The Ontrack PowerControls ExtractWizard extracts both private 
and public Exchange Information Store data from tape and disk backups to any alternate location 
(e.g., machine, volume, folder), thereby eliminating the need for a recovery server. In contrast, 
most backup programs let you restore Exchange data only to the same or duplicate server from 
which it was backed up. 

The Direct Method of extracting backed-up Exchange data reads the tape or disk file directly 
without needing the original backup software installed. This method is useful if the original backup 
software is unavailable and you know the tapes on which the Exchange Information Store backups 
reside. For more information, see “Method of Extraction” on page 19.
The Advanced Method uses your existing backup software to extract an Exchange database from a 
backup server or tape library, across the network, to the computer running Ontrack PowerControls 
ExtractWizard. The Advanced Method takes full advantage of your backup software’s knowledge 
of individual set locations and robotic library support. This is the fastest method to extract an 
Exchange Information Store from the most recent backups managed by your backup server.

For information about the Advanced Method of extracting backed-up Exchange data, see “Using 
the Ontrack PowerControls ExtractWizard Advanced Method” on page 37.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Prerequisites

• Ontrack PowerControls ExtractWizard requires that the tape drive be configured and active 
in the Device Manager.

• Ontrack PowerControls ExtractWizard works best with Windows drivers supplied directly 
from the manufacturer of the tape drive hardware.

• If Ontrack PowerControls ExtractWizard is installed on your backup server, make sure the 
services for the backup software are disabled.
Copyright © 2007 Kroll Ontrack Inc. 17
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Ontrack PowerControls ExtractWizardCHAPTER 1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls ExtractWizard

The Ontrack PowerControls ExtractWizard steps you through the extracting process of both private 
and public Exchange Information Store data from tape and disk backups to any alternate location.

Welcome Page

1. Click Start, and then point to Programs. Point to Ontrack, point to PowerControls, and 
then click Ontrack PowerControls ExtractWizard. The first page describes the wizard. 

Figure 1-1. Ontrack PowerControls ExtractWizard Welcome Page

2. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Ontrack PowerControls ExtractWizard agents are active. For more information, see 
“Enabling the Licensed Agents” on page 9.

3. Click Next.
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Ontrack PowerControls ExtractWizard
Method of Extraction

The second page of the Ontrack PowerControls ExtractWizard offers two methods of extracting 
backed-up Exchange data: “Direct Method” on page 19 and “Advanced Method” on page 20.

Figure 1-2. Selecting IBM Tivoli Storage Manager in the Method of Extraction Advanced Method

DIRECT METHOD 
The Direct Method reads the tape or disk file directly without needing the original backup software 
installed. This method is useful if the original backup software is unavailable and you know the 
tapes on which the Exchange Information Store backups reside. 

The Direct Method has the following requirements:
• The tape drive must be directly attached to the computer and configured and active in the 

Windows Device Manager.
• The latest Windows drivers supplied directly from the manufacturer of the tape drive 

hardware should be installed for best results.
• Both online and offline Exchange backups are supported.
• As Ontrack PowerControls ExtractWizard reads tapes one at a time, you must manually 

insert and eject each tape when prompted.
• Ιf Ontrack PowerControls ExtractWizard is installed on your backup server, make sure the 

services for the backup software are disabled. 
Copyright © 2007 Kroll Ontrack Inc. 19










































